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Abstract
Electric Cell-substrate Impedance Sensing (ECIS) is an in vitro impedance measuring system to quantify the behavior of cells within adherent
cell layers. To this end, cells are grown in special culture chambers on top of opposing, circular gold electrodes. A constant small alternating
current is applied between the electrodes and the potential across is measured. The insulating properties of the cell membrane create a
resistance towards the electrical current flow resulting in an increased electrical potential between the electrodes. Measuring cellular impedance
in this manner allows the automated study of cell attachment, growth, morphology, function, and motility. Although the ECIS measurement itself
is straightforward and easy to learn, the underlying theory is complex and selection of the right settings and correct analysis and interpretation
of the data is not self-evident. Yet, a clear protocol describing the individual steps from the experimental design to preparation, realization,
and analysis of the experiment is not available. In this article the basic measurement principle as well as possible applications, experimental
considerations, advantages and limitations of the ECIS system are discussed. A guide is provided for the study of cell attachment, spreading and
proliferation; quantification of cell behavior in a confluent layer, with regard to barrier function, cell motility, quality of cell-cell and cell-substrate
adhesions; and quantification of wound healing and cellular responses to vasoactive stimuli. Representative results are discussed based on
human microvascular (MVEC) and human umbilical vein endothelial cells (HUVEC), but are applicable to all adherent growing cells.

Video Link
The video component of this article can be found at https://www.jove.com/video/51300/

Introduction
ΩΩΩHere we present Electric Cell-substrate Impedance Sensing, known as ECIS, a specific method to measure and analyze the impedance
1
spectrum of adherent cells in culture . The aim of this protocol is to offer a generally applicable guide for the usage of this particular type of
impedance based cellular assays and provide protocols for some of the key functions from the constantly growing number of applications. The
focus will be on the study of cell proliferation, barrier function, cell junctions, and cell motility.
Since ECIS and its associated model to transform the impedance spectroscopy data in biologically relevant parameters was introduced in its
2
current form to the scientific community by Giaever and Keese in 1991 , it has often been referred to as a system for the measurement of TEER
(trans-epithelial electrical resistance), which is not accurate. The differences seem marginal at first, but are important for the data interpretation.
For classical TEER measurements, cells are grown on permeable filters to characterize paracellular transport mechanisms, which are dominated
3
by epithelial tight junctions or endothelial adherens junctions . Commonly, two electrodes positioned above and below the filter are used to
4
apply a direct current (DC) flow over the cell layer and two other electrodes to measure the resulting voltage drop . The electrical resistance is
calculated using Ohm's law, which allows a numerical description of the quality of the cell barrier.
ECIS follows this basic principle and extends it. In the ECIS system, cells are grown on opposing, circular gold electrodes that are embedded in
the bottom of special cell culture dishes. The number of electrodes per culture well is variable, dependent on the application and the electrodes
have a standard diameter of 250 µm; in some cases a larger counter electrode is used to complete the circuit. ECIS uses a constant alternating
current (AC) of 1 µA with a given frequency instead of a direct current. The impedance is calculated from the corresponding changes in voltage
(in mV) between electrodes. ECIS offers the possibility to measure the impedance over a range of frequencies to study frequency dependent
cellular properties, which has several advantages over TEER and will be explained in detail in this article. First, measuring complex impedance
allows separating the overall impedance into cell barrier resistance and cell capacitance. In addition, by taking data at multiple frequencies and
applying a mathematical model, one can differentiate between junctional impedance (tightness of cell-cell contacts) and impedance caused by
cell-substrate interactions (distance of basal cell membrane to underlying matrix) as well as the contribution of the cell membrane capacitance.
Second, cell proliferation and motility can be assessed, since the cells are in direct contact with the electrodes. Third, substrate and electrodes
are sufficiently thin to allow for bright field and phase contrast microscopy.
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Basis of impedance measurements: The complex impedance
The basis for the measurement of the electrical impedance of biological objects (e.g. cells) is Ohm's law, a basic electro-technical principle,
which describes the relation between resistance (R), current (I) and voltage (U) in an electrical circuit at a given time (t).
Applicable in DC circuit: R(t) = U(t)/I(t)
When working in the AC system, current and voltage not only differ in their amplitude, but also in their phase (φ). Now, resistance is no longer
sufficient to describe these relations. Instead, the complex impedance (Z) or in most cases the magnitude of the impedance (|Z|) are used,
containing the previously described ohmic resistance plus reactance (X), which results from AC flow through capacitors and inductors driving the
5
phase shift between voltage and current .
2
2
Applicable in AC circuit: |Z(f)| = √(R +X(f) )
φ = arctan(X/R)
When performing impedance measurements on intact cells, due to the characteristics of their membrane, cells act as a parallel connection of
resistor and capacitor. Here, resistance represents the opposition to current flow, whereas capacitance (C) describes the separation of electric
carriers at the insulating bi-layer of the cell membrane that causes polarization of the cell. Thereby X is dominated by the capacitive properties of
the cell membrane.
-1
X(f) ≈ (2*Pi*f*CCell)
Since X is frequency dependent, variation of the measurement frequency enables study of different functional and structural properties of the
cell. The ECIS device measures both R and X, allowing calculation of |Z|, C and φ.
Quantifying entire cell layers with impedance spectroscopy: The electrical equivalent circuit.
As previously explained, when a cell is brought into an electrical field, it shows properties of passive electronic components. If now, instead of a
single cell, an entire cell layer grown on top of electrodes and supplemented with cell culture medium is investigated, the simple model of resistor
and capacitor needs to be extended to an entire electrical network. In this so-called equivalent circuit, resistance of the culture medium (RMed) as
3,6
well as capacitance (CElectr) and resistance (RElectr) characterizing the electrode/electrolyte interaction need to be considered .
A simplified, general example of such an equivalent circuit for an adherent growing cell layer can be found in Figure 1. The advantage of such a
mathematical approach to describe a biological system is that those circuits can be refined ad libitum and adjusted to the specific experimental
questions, e.g. by considering impedance caused by intra-cellular organelles or to distinguish influences of cell-cell (RJunc) and cell-substrate
7,8
adhesions (RSub) on overall impedance . Nevertheless the aim for the modeling should always be to use the smallest number of elements
describing all features of the measured impedance spectrum to allow meaningful correlations.

Figure 1. Schematic of the ECIS system and representative equivalent circuit for an adherent growing cells layer. A) Cross section of
an ECIS culture well. The cells are growing on top of sensing and counter electrode and are covered with culture medium. The electrodes are
connected to a lock-in amplifier and an AC signal is applied via a 1 MΩ resistor to create a constant current source. Stimuli can be added directly
to the culture medium at any point in time. B) ECIS measures the sum of all individual contributions to the impedance. Resistance of the culture
medium (RMed) as well as impedance caused by the electrode/electrolyte interface, which is for simplicity presented as a parallel combination
of a resistor (RElectr) and a capacitor (CElectr), and also the electrical properties of the cell membrane, described by a parallel connection of
resistance (RCell) and capacitance (CMem), all need to be considered. RCell is variable, since it is dependent on the cell permeability towards
the current. The equivalent circuit can be extended and refined ad libitum. As an example junctional (RJunc) as well as subendothelial (RSub)
resistance were added to the circuit. Please click here to view a larger version of this figure.
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Impedance parameters and their biological meaning
The two most direct parameters derived from impedance measurements are resistance and capacitance of cells. Resistance represents quality
and function of the cell barrier and therefore takes into consideration the resistance towards para- and trans-cellular current flow. Capacitance
provides an overall measure of electrode coverage. The distinctive feature of the ECIS is that with the help of equivalent circuits and modeling
those global parameters provide insights on many more cellular properties, including cell-cell and cell-substrate adhesions, which will be
discussed later in this article.
Before starting: Experimental considerations
Measurement setup - The setup consists of several separate components: ECIS device with measurement electronics; PC for data acquisition;
array holder for the 8- or 96-well system; ECIS arrays and the cell culture of choice. The array holder must be placed in an incubator and
connected to the ECIS device outside the incubator. The PC needs to be equipped with the ECIS software (1.2.123.0 14th February 2013) and
connected to the ECIS device.
Array selection - There is a continuously growing variety of ECIS arrays, designed for multiple applications. The standard arrays are the 8W1E
and the 8W10E arrays, which are composed of 8 culture wells (indicated by W) comprising 1 or 10 measurement electrodes (indicated by E),
6
respectively. A large counter electrode completes the circuit, but its impedance is essentially negligible in the actual measurement . The standard
8-well array holder can host two arrays, resulting in a total number of 16 culture wells. The gold electrodes are 50 nm thick, delineated with an
insulating film and mounted on either an optically clear Lexan polycarbonate substrate or a printed circuit board (PCB). The PCB arrays are
more robust and cost efficient. The transparent slides allow for light and immunofluorescence microscopy. What must be considered is that
the 1E array enhances fluctuations in the resistance signal caused by cell motions and is needed for wound healing studies. In addition, single
electrodes allow correlation of electrical and optical signals. In the multi electrode arrays, the signal is averaged over several electrodes, which
due to the increased measurement area includes more cells in the measurement, limits bias of the data by uneven inoculation and growth of the
cells and reduces blurring of the signal due to cell motions. Therefore, the multi electrode arrays are useful to study cell proliferation and barrier
9
10
formation. Next to standard arrays there are special arrays available for the application of shear stress , to study chemotaxis , cell migration,
and proliferation as well as 96-well plates for high throughput screenings. To conclude, the array to be used is strongly dependent on scientific
question and cell type and should be selected and tested carefully.
Measurement frequency - The modeling of Rb and alpha (see data analysis) requires multi frequency measurements (MFT). Otherwise
impedance can be measured over time at one cell type specific frequency (SFT), with the advantage that data can be collected with a higher
temporal resolution. The most sensitive measurement frequency for a specific cell type can be found by frequency scans. When plotting
impedance respectively resistance vs. frequency in a log-log graph the frequency where the difference between cell-free and cell-covered
electrode is biggest is the frequency where the cells block the current most effectively. In case of endothelial cells (EC) this frequency is at about
4 kHz.
Seeding density - As in every regular cell-based experiment seeding density depends on the scientific problem. When studying adhesion and
2
spreading or barrier formation, endothelial cells should be seeded with a high density of 40,000-60,000 cells/cm to guarantee a confluent, stable
barrier after 48 hr. If the focus of the experiment is on proliferation, endothelial cells should be seeded with a low density of about 2,000-10,000
2
cells/cm .

Protocol

1. Preparation of Measurement System
1. Prewarm the array holder in an incubator to 37 °C before starting the experiment to prevent condensation.
2. Fill water casket of the incubator with distilled water to avoid drying of the wells.
3. Perform all manipulations on cells and arrays in a laminar flow cabinet under sterile conditions.

2. Preparation of Arrays and Inoculation of Cells
NOTE: The ECIS arrays need to be cleaned and stabilized before an experiment to prevent electrode drift, to improve well-to-well reproducibility
and signal-to-noise ratio. Therefore two options are available: A) pretreatment of the electrodes with L-cysteine and B) the stabilization function
of the ECIS.
Option A: L-cysteine is recommended as the most consistent pretreatment, but might in some special cases interact with protein coatings on the
electrodes. The volumes presented are used for standard 8-well arrays.
1. Add 200 µl/well 10 mM L-cysteine. Cysteine cleans and modifies the electrode surface providing a high and reproducible electrode
capacitance.
2. Incubate 15 min at room temperature (RT).
3. Wash twice 500 µl/well with ultra-pure water (type 1). Do not use phosphate buffers, which can interfere with the adsorption of some proteins.
Also avoid serum-containing solutions before coating, since the gold surface will adsorb the first macromolecules brought in contact.
4. Coat with 200 µl/well warm 1% gelatin.
5. Incubate 30 min at 37 °C.
6. Remove gelatin, but don't let surface dry. This can damage the electrodes.
7. Wash once with ultra-pure water (type 1).
8. Add 400 µl/well complete cell culture medium (containing serum, antibiotics and all growth factors).
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9. Slide array into array holder and make sure that the array is positioned such that the nine gold square pads are properly contacted by the
spring-loaded pogo pins and fix adjustment screw hand tight. Be careful with transparent arrays, the gold layer can easily be damaged.
10. Open the measurement software and press Setup followed by Check in the "Collect Data" section to perform a quick impedance
measurement of each individual well. The resulting values are the measurement baseline and will automatically be stored in the "Comments".
11. The well check will automatically determine the type of ECIS arrays used. Verify the selected arrays in the "Well Configuration" section.
12. The array diagram lights up green for properly connected wells and red for empty or incorrect connected wells. Still, always make sure that
the arrays were placed correctly in the holder.
NOTE: If cleaning and coating were successful the 8W1E ECIS arrays have a capacitance of about 5 nF and the 8W10E arrays of 50 nF,
which results in a baseline resistance of about 2,000 and 200 Ω, respectively.
13. Remove array from holder.
14. Seed cells as a single cell suspension in 400 µl/well complete cell culture medium.
Option B: The stabilization function of the ECIS can be used as an alternative or in combination with the L-cysteine treatment and if problems
with electrode drift or large differences in well-to-well resistance and capacitance occur.
1. Perform cysteine treatment (optional) and precoat electrodes with protein (optional).
2. Add 200 µl/well of complete medium to each well and place the array in the array holder.
3. Open measurement software and press Setup followed by Check to ascertain the array is properly connected and to measure initial Z, R,
and C.
4. Stabilize the electrodes by pressing Stabilize in the "Collect Data" section. The ECIS will apply a high current (ca. 3 mA), high frequency (64
kHz) pulse to clean the electrodes.
5. Check electrodes again. Capacitance should be increased and resistance values should be in a comparable range.
6. If capacitance and resistance values are still not satisfactory, repeat the stabilization.
7. Remove array from the holder and inoculate cells.

3. Setting up Measurement Software and Data Acquisition
1. Place the array in the array holder as described before.
2. Open measurement software and press the Setup button in the "Collect Data" section to connect the ECIS software to the ECIS instrument
and run another well Check.
3. Verify the selected arrays in the "Well Configuration" section.
4. Select the wells to be measured in the "Well Configuration" section.
5. Select the measurement mode from the "Collect Data" options:
1. For a time series at a fixed frequency, select Single Freq. / Time (SFT) and choose the measurement frequency from the drop down
menu.
2. For measurement of electrode coverage and modeling of Rb and Alpha, select Multiple Freq. / Time (MFT). The ECIS device will
measure automatically at all available frequencies.
3. For micromotion (see data analysis) select Rapid Time Collect (RTC) and adjust measurement frequency and sampling frequency.
Here the standard temporal resolution is one sample per sec (1 Hz), but sampling frequency can also be increased to track fast
changes in impedance up to 25 Hz (for the Z-Theta). Important note: in RTC mode only a single well is measured.
NOTE: If micromotion need to be measured in several wells subsequently, go to Help > Show expert toolbar/menu items > Acquire >
Multi-Well RTC. Specify the Time limit (hr) in the Collect Data section; the ECIS will now measure the selected wells in numerical order.
After starting the measurement the software will ask to specify the numbers of cycles. Enter the value for how often the measurement
needs to be repeated.
6. For SFT and MFT, select the time Interval (sec) between measurements or if data need to be acquired as fast as possible leave this option
unchecked.
NOTE: To acquire data the ECIS device uses a multiplexer to switch from one well to another with a minimum SFT acquisition rate of 0.25
sec and 7.5 sec for MFT. Meaning the interval is dependent on number of selected wells and frequencies. For measurements on slow
proliferating cells or a simple recording of resistance vs. time, use intervals of 600 sec or more.
7. Press Start, name the file and select location to store the data.
NOTE: File size should not be a problem, since ECIS data are saved in a kind of plain text format called *.abp, which never exceeds
several hundred MB even with all measurement frequencies and number of wells selected.
8. Stop run by pressing Finish.

4. Medium Change and Cell Manipulation
1. Press Pause, this will stop the data acquisition, but continue to run the experimental clock.
2. Remove the array from the holder and manipulate it under a laminar flow bench (i.e. change medium).
3. Place array back in the holder and either click Check Connection or Resume Experiment to continue data acquisition. The measurement
software will place a time mark in the data set.

5. Acute Stimulation During Data Acquisition
NOTE: A second option is to manipulate the cells during data acquisition to follow immediate changes. This is only possible when samples don't
needs to be sterile in the further course of the experiment.
1. Add the stimulus directly to the well and make sure to mix careful with a 200 µl pipette.
Copyright © 2014 Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
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2. Mark time point manually by pressing Mark and add a comment.

6. Electrical Wounding
NOTE: Finding the right settings for the used cell type is key for electrical wounding. If wounding is too short this can result in insufficient removal of
cells, whereas if wounding is too long and/or rough this can damage the electrodes (especially on the transparent arrays). Therefore, several short
wounding pulses are recommended. For HUVEC cultures two 10-20 sec long wounding pulses of 5 V at 60 kHz each have been found optimal
using the ECIS 1600R. In general it is recommended to use high frequencies >20 kHz to maintain uniform high fields across the cells and to avoid
any damage to the electrodes.
1. Perform wounding during an active ECIS measurement.
2. Enable Wound / Electroporate Setup, then click Wound and fill in the time (sec), wound voltage (V for 1,600 R) or current (µA for Z and ZTheta) and frequency (Hz). The displayed default values are based on the type of array and ECIS device.
3. Select the wells to wound in the "Well Configuration" section. Only the checked wells will be wounded.
4. Enable Delay Until Hour and fill in the delay time to activate the delay wound function. This function can be stopped at any time by pressing
Stop or applying a wound manually. Only one delay command can be active at a time.
5. Press Activate and click OK in the pop-up window to start wounding.
6. Make sure that the resistance signal drops to the offset impedance after wounding, otherwise repeat the wounding.

7. Data Analysis
1. Data representation and exporting.
1. Finish measurement or load data set via File -> Open.
2. Select wells to be displayed from the "Well Configuration" window. Group individual wells to present the average.
3. Chose parameter to be displayed from the upper toolbar (Z, R or C).
4. Select graph type from the upper toolbar (T = time, F = frequency, 3D = waterfall blot).
5. Define graph offset and range with the sliders below the graph window or fill in the exact values in the adjacent controls.
6. Chose from the basic "Time-Series Options" in the "Analyze" section to perform standard deviation, running average or normalization of
the data.
7. Activate Expert Toolbar in the Help menu for more advanced operations like Nyuist plot and Fourier transformation.
8. Use "Display Options" in the "Analyze" section to define range of x- and y-axes and export graph.
9. Export selected data to an Excel file via File -> Export Data -> To Excel (Selected) and use a third party software of choice for in
depth analysis, statistics and representation as needed.
2. Modeling of Rb and Alpha.
NOTE: For modeling it is recommended to use a cell-free, medium filled well as reference.
1. Finish MFT measurement or load MFT data set.
2. If a cell-free reference well is available press either Find to automatically select the reference value or Set to select the cell free time
point manually from "Freq. Scan Modeling" in the "Analyzing" section.
3. If there is no cell-free reference, import a reference value from another data set. Open the reference data set (make sure that the same
array and medium was used) and use Find or Set to select the reference value. Then navigate to the measured data and press Get.
4. If there is no cell-free reference data set available use the factory default.
5. Press Model to start the calculations. Modeling might take several minutes dependent on the size of the data set.
3. Calculation of micromotion.
NOTE: This calculation is not part of the measurement software, but can be performed with any signal processing software.
1. Finish RTC measurement or load RTC data set.
2. Normalize data set by the averaged resistance of the entire period.
3. Break data set into segments with a length of 256-data points and clean each segment by a Hanning window.
4. Run a 256-point Fourier transformation and average resulting frequency spectra to a single-sided 129-point power spectrum to
minimize random noise and enhanced the biological signal.
5. Plot frequency against amplitude in a log-log graph and apply least square linear fit.
6. The slope of the linear fit is a measure of overall noise in the signal and thereby micromotion of the cells.

Representative Results
Setting up an experiment is fairly simple and the measurement itself is fully automatic, but as is often the case, correct analysis and interpretation
of the data are crucial. In the representative data section a guide is provided for the interpretation of the most important parameters provided by
impedance spectroscopy with ECIS. This will be helpful to decide for which kind of scientific problem an ECIS measurement can be useful and
which parameters should be recorded.
A typical experimental read-out can generally be divided in a growth-phase after cell inoculation and a plateau-phase when cells reach
confluence. Each of these phases yields information on different cellular properties. A representative measurement is shown in Figure 2 and
divided into four subphases to analyze A) cell adhesion, spreading and proliferation; B) formation of a maturation EC barrier; C) cell migration
after the generation of an electrical wound; and D) the cellular response to stimulation with the vasoactive agent thrombin. Phase-contrast and
immunofluorescence images were acquired directly from the measurement electrode during the different subphases to illustrate the link between
electrode coverage, cell status, and recorded impedance signal.
Copyright © 2014 Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
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Adhesion, spreading and proliferation
Every cell type has its characteristic adhesion and growth curve that can be manipulated by varying seeding density, coating with extracellular
matrix proteins or other stimuli. One of the major difficulties to study those processes is to differentiate between adhesion, spreading and
11
proliferation. Wegener et al. gave a detailed description for the use of a combination of resistance and capacitance to distinguish between
those parameters and in Figure 3 it becomes obvious how resistance and capacitance can complement each other. It is important for the study
of adhesion and spreading to understand the influence of the measurement frequency, because here the electrical field causes a polarization
8
of the cell membrane of the cells in suspension , which forces the current to flow exclusively around the cells. When the cells attach they start
to restrict the current flow by spreading over the electrode and capacitance decreases in a linear fashion with the percentage of open area on
the electrode (fractional area). Hence, adhesion, spreading and proliferation can be quantified best, when recording capacitance at a frequency
higher than 40 kHz (Figure 3B), where the decrease in capacitance is direct proportional to the electrode coverage. Alternatively resistance at its
most sensitive measurement frequency is a direct measure for the differentiation and maturation of cells into a confluent barrier (Figure 3A). In
addition to the fractional area, Wegener et al. introduced two other parameters to quantify adhesion and electrode coverage: t1/2 (half maximum
capacitance), which is the time until 50% of the electrode is covered with cells (Figure 3B, insertion), and the slope of the capacitance curve (s,
not shown) as the rate of cell spreading and proliferation.
Resistance as a measure of barrier quality
Resistance is the part of impedance that describes barrier quality and function best, because it neglects capacitive components from membrane,
electrode and medium. Here the term barrier quality and not permeability is used, since permeability is per definition only dependent on cellcell contacts. Resistance however is determined by the ability of cells and their cell-cell and cell-matrix interactions to block the current flow.
Accordingly different cell types (clones and passages) have their specific resistance values (Figure 4A). Although resistance gives a much
clearer idea about the cell barrier, the impedance signal should always be taken into consideration.
Modeling of Rb and Alpha
The ECIS software harbors a particular feature, the ability to model two parameters, which distinguish between cell-cell and cell-matrix
2
adhesions (Figures 4B and 4C). Rb (in cm x ohm), is the resistivity of cell-cell contacts to the current flow and thereby an inverse measure
0.5
of classical permeability. High Rb implies low permeability towards the current flow. Alpha (in cm x ohm ), is a measure for the impedance
contributions arising from the cell-electrode junctions. The model to quantify cell-cell and cell-matrix contacts was introduced 1991 by Giaever
and Keese and is based on the assumption that cells are circular, disc shaped objects that have an insulating membrane, hover over the
2
electrode and are filled with conducting electrolyte . The insulating property of the cell membrane leaves only three pathways for the current:
a) between ventral surface of the cells and electrode, b) between the cell-cell contacts, and c) through the cells (only likely when a high
3,12
measurement frequency is used). A more detailed derivation and explanation can be found in the papers of Lo et al .
Micromotion
It has been shown that small fluctuations in the resistance signal (Figure 4A) are due to subtle, random cell movements in confluent cell layers
2
13,14
as well as cells moving on and off the electrode in sparse cultures . This aspect of ECIS time-course data described by Lo and Opp et al.
is
often overlooked and best seen when measuring with the 1E arrays and at the most sensitive frequency to account for para- and subcellular
current-paths. The calculation of this cell caused noise (micromotion) is not part of the standard measurement software, although in the newest
version Fast Fourier Transformation (FFT) is integrated. Recording RTC data with a sampling frequency of 1 Hz for 1 hr at 4 kHz provides
sufficient resolution for the calculation of EC micromotion. This calculation provides one single value and can be directly used for statistical
15
analysis. An extended discussion on the use of frequency analysis for micromotion can be found elsewhere . Alternatively to FFT other analysis
strategies can be used, like variance of the increments. Variance is more sensitive towards small changes in micromotion, but because of this
sensitivity the comparison of individual experiments becomes difficult. The slopes of the power spectrum are a more robust measurement of
micromotion (Figure 4D). Here the area under the curve can be seen as the amount of micromotion or noise the cells create. Hence, the steeper
the slope of the power spectrum the smaller the area under the curve and the smaller the micromotion.
Electric wound healing assay
To study migration of cells, usually mechanical wounds are applied by scratching cells off the culture plate with pipette tips, cell scrapers or
16
specific stamps and follow their remigration microscopically . This method has the obvious disadvantage that the size of the scratch varies
and is usually too big to neglect the influence of cell proliferation on the wound healing process. The wounding function of the ECIS uses a
high voltage, high frequency pulse to get a cell free electrode and subsequently follows remigration of neighboring cells to replace the death
cells (Figure 5A). An advantage of this automated method over standard, labor intensive scratch assays is that the ECIS produces a highly
reproducible wound with a precise diameter of 250 µm, that closes within a few hours, to study pure migration. Further, the electrical pulse does
not remove protein coating and secreted extracellular matrix. Under the assumption that the cells remigrate on the electrode from all sides, the
17
migration rate can easily be calculated by dividing wound radius by time required for wound closure . As an alternative to electrical wounding,
recently the so-called electric fence method was introduced (not shown). Here high current pulses prevent attachment and migration of cells on
the electrodes after inoculation. The cells will grow around the measurement electrode and start migrating inwards as soon as the electric pulses
are turned off. The advantage of the electric fence over the electric wounding is that the electrode surface hasn't been altered by cell growth or
cell removal, which is important to measure influences of different coatings on cell migration.
Cell stimulation
In addition to the study of cell migration, impedance spectroscopy is perfectly suited to measure the effects of drugs and toxins on cells. Figure
5B presents a classical stimulation/inhibition experiment, where thrombin was used to induce hyper-permeability in the confluent EC barrier
by contraction and gap formation of cells, which manifests as a transient drop in resistance. By preincubation with the Rho kinase inhibitor
18
19
Y-27632 most of the thrombin response is diminished by lowering basal cell tension and blocking stress fiber formation . Then the Rho
kinase blocker was used at different time points after thrombin addition, leading to an immediate and total recovery of the EC barrier. Here the
Copyright © 2014 Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
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advantage of a continuous impedance measurement system to study acute cellular responses becomes obvious. In regular endpoint assays
(e.g. immunofluorescence staining or macromolecule passage), this acute response to the used blocker would be very difficult if not impossible
to detect and quantify. Important to note is that with impedance measurements the permeability towards ions is described and not towards
20
macromolecules. Please refer to Aman et al. , where an excellent comparison between ECIS measurements and macromolecule passage
experiments is provided.

2

Figure 2. Representative measurement. MVEC were grown on a gelatin coated 8W1E arrays with a low seeding density of 5,000 cells/cm
and MFT recording was performed over 10 days. The measurement illustrates the different read-outs of an ECIS experiment: A) adhesion,
spreading and proliferation; B) formation and maturation of a confluent cell barrier; C) wound healing after the application of an electrical wound;
D) stimulation with the vasoactive agent thrombin. The two arrows indicate medium refreshments, which were performed in intervals of 4 days
and give an idea about the sensitivity of the measurements towards mechanical stimuli and changes in temperature and pH. The images in
the top panel correspond to the measurement and were acquired directly from the measurement electrode. The phase-contrast image on
the left shows the endothelial cells 24 hr after inoculation, starting to cover the electrode. The immunofluorescence pictures in the center and
on the right present F-actin staining of the confluent endothelial layer before and after stimulation with thrombin (1 U/ml). Thrombin causes
contraction of endothelial cells by formation of so called stress fibers and the transient opening of inter-endothelial gaps (arrows and image
inserts), recognizable in the ECIS signal by a drop in resistance to baseline. Here the sensitivity of the measurement becomes obvious and how
changes in the cell layer correlate with the impedance signal. Please click here to view a larger version of this figure.
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Figure 3. Cell attachment and growth. MVEC from the same donor were seeded with three different densities on gelatin coated 8W10E arrays
and cell growth was recorded at multiple frequencies for 60 hr. A) Resistance values for the three conditions at their optimal frequency of 4
kHz to measure barrier formation. All three seeding densities established a confluent barrier of ca. 1,200 Ω at the end of the measurement; the
proliferation rates however (slopes of the curves) differ markedly. B) Measurement of capacitance at 64 kHz provides insights on adhesion and
spreading. Adhesion is the initial plateau phase in the capacitance curve (between 2-8 hr). Spreading, which is in linear relation to the electrode
coverage, is represented by the slope of the curve and is completed after 10-30 hr depending on the seeding density. The time point t1/2 (half
maximal coverage) can be used for statistical analysis. Please click here to view a larger version of this figure.
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Figure 4. Characterization of the confluent barrier. Two MVEC donors with different passage numbers (passage 3 and 6) were seeded on
gelatin coated 8W1E arrays and a MFT measurement was performed for 30 hr to characterize the EC barrier. A) Resistance measurements
reveal that the younger donor 1 has a higher resistance of ca. 11,000 Ω in comparison to the ca. 7,500 Ω of the older donor 2. B-C) The
modeling capabilities of the ECIS have been used to find the cause for the lower resistance. Modeling revealed a comparable cell-cell interaction
Rb and indicated a weakened cell-matrix interaction Alpha as a possible cause. D) RTC was performed to quantify micromotion within the
confluent cell layer by Fourier transformation, where the area under the curve is proportional to micromotion. Analyses of the spectra shows less
micromotion of the older donor 2 and thereby support what can already be assumed from the resistance signal (less variance). Please click here
to view a larger version of this figure.
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Figure 5. Cell migration after electric wounding and effects of thrombin stimulation. Impedance recordings were performed at 4 kHz with
maximal temporal resolution. A) MVEC donor 1 was used in passage 3 and donor 2 in passage 6 on gelatin coated 8W1E arrays and grown
to confluence. Then an electrical wound was created by application of two 5 V pulses at 60 kHz with a duration of 20 sec each. The younger
donor 1 showed better wound healing capabilities based on a faster wound closure (migration, slopes of the curves) and a higher resistance
after wounding in comparison to the older donor 2. B) HUVEC were grown on gelatin coated 8W10E arrays. Upon confluence the cells have
been serum starved for 1.5 hr by replacing the complete culture medium with basal medium plus 1% human serum albumin (HSA). Usage of
plain medium with HSA is a critical step, since serum components block the thrombin response. As soon as a stable resistance plateau was
detected, thrombin was added directly to the wells and mixed carefully with a 200 µl pipette. The maximal thrombin effect is visible after 30 min,
characterized by a transient drop in resistance to baseline and a ca. 30-50% lower resistance after recovery. The cells were either preincubated
with the Rho kinase blocker Y-27632 for 30 min or the blocker was added 20, 30, or 40 min after thrombin addition, which diminished the
thrombin effect immediately. Please click here to view a larger version of this figure.
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Discussion
ECIS is an excellent tool for the screening of cell properties and behavior as well as for the quantification of the effects of known and
unknown substances. Thereby the cells are held under standard culture conditions, impedance can continuously be monitored with a high
temporal resolution and correlated to optical signals. That way the optimal time point for cell manipulations can be chosen on the basis of
the morphological and functional cell status. Unfortunately, this high measurement resolution comes with the price that small changes in
temperature, pH or mechanical stimulation of cells (medium change) will influence the impedance signal immediately.
The application of the small measurement current to the cells makes the ECIS measurement noninvasive, nondestructive, and label-free, but
as a result only passive bioelectrical properties can be measured (no action potentials). A key feature is that a number of parameters can be
derived from a single measurement, combining the information from several classical assays, like permeability or wound healing assays. Here
the particular interesting aspect is that mathematically modeled data can be used to explore changes in resistance and capacitance and refer
them to distinct cellular structures (e.g. cell-contacts or cell membrane). Important to note is that impedance spectroscopy always provides an
averaged signal from all cells on the sensing electrode, which does not allow for studies on single cells and also the mathematical model is only
valid in confluent cell layers. Therefore endothelial cells should be held in the confluent state for at least one day before used for modeling to
ensure mature cell-adhesions and quiescent cells. Equally, electrical wounds should only be applied to confluent cell layers using multiple short
wounding pulses with high frequencies, to achieve optimal wounding efficiency and prevent damage of the electrodes.
To get the maximal amount of information from an ECIS measurement, as in every assay, several parameters such as the combination of array
substrate, coating and seeding density for the individual cell type need to be tested and optimized before an experiment.
A major limitation of ECIS is that the measurement does not provide direct information on the molecular level. Thus ECIS measurements are
usually most informative at the beginning of an experimental series to help associate a scientific problem with cellular structures or properties
and provide significant input for the generation of a testable hypothesis. Therefore the modular design of ECIS provides a wide spectrum of
applications with the possibility for tailor made arrays. The latest array developments indicate a future focus on high throughput impedance
screenings for cell proliferation and electrical wounding and the advance of special flow arrays for the simulation of in vivo shear stress with
different flow profiles.
Further literature
Please also refer to the webpage of Applied BioPhysics (www.biophysics.com) for application notes, webinars and a detailed list of publications
covering the entire ECIS spectrum.

Disclosures
Applied BioPhysics Inc. covered the open access fees, whereas structure and content of the article remained full responsibility of the authors.

Acknowledgements
The authors would like to thank Dr. Charles Keese, Dr. Christian Renken, Christian Dehnert (Applied BioPhysics Inc.) and Dr. Ulf Radler (ibidi
GmbH) for their advice, help and the fruitful discussions during the preparation of this manuscript. Further we would like to thank Jan van Bezu
for his excellent technical support. This research was conducted with support from the Dutch Lung Foundation (Longfonds), Grant number
33.12.036.

References
1. Giaever, I., & Keese, C. R. A morphological biosensor for mammalian cells. Nature. 366 (6455), 591592 (1993).
2. Giaever, I., & Keese, C. R. Micromotion of mammalian cells measured electrically. Proc. Natl. Acad. Sci. U.S.A. 88 (17), 78967900 (1991).
3. Lo, C. M., Keese, C. R., & Giaever, I. Cell-substrate contact: another factor may influence transepithelial electrical resistance of cell layers
cultured on permeable filters. Exp. Cell Res. 250 (2), 576580 (1999).
4. Wegener, J., Sieber, M. & Galla, H. J. Impedance analysis of epithelial and endothelial cell monolayers cultured on gold surfaces. J. Biochem.
Biophys. Methods. 32 (3), 151170 (1996).
5. Pänke, O., Balkenhohl, T., Kafka, J., Schäfer, D., & Lisdat, F. Impedance spectroscopy and biosensing. Adv. Biochem. Eng. Biotechnol. 109
(11/2007), 195237 (2008).
6. Wegener, J., Zink, S., Rösen, P., & Galla, H. Use of electrochemical impedance measurements to monitor beta-adrenergic stimulation of
bovine aortic endothelial cells. Pflugers Arch. 437 (6), 925934 (1999).
7. Eker, B., Meissner, R., Bertsch, A., Mehta, K., & Renaud, P. Label-free recognition of drug resistance via impedimetric screening of breast
cancer cells. PloS ONE. 8 (3), e57423 (2013).
8. Nacke, T., Anhalt, M., Frense, D., & Beckmann, D. Anwendungsmöglichkeiten der Impedanzspektroskopie in der Biotechnologie (Application
of the Impedance Spectroscopy in the Biotechnology). Technisches Messen. 69 (1/2002), 12-18 (2002).
9. DePaola, et al. Electrical impedance of cultured endothelium under fluid flow. Ann. Biomed. Eng. 29 (8), 648656 (2001).
10. Pietrosimone, K. M., Yin, X., Knecht, D. A., Lynes, M. A. Measurement of Cellular Chemotaxis with ECIS/Taxis. J. Vis. Exp. (62), e3840,
doi:10.3791/3840 (2012).
11. Wegener, J., Keese, C. R., & Giaever, I. Electric cell-substrate impedance sensing (ECIS) as a noninvasive means to monitor the kinetics of
cell spreading to artificial surfaces. Exp. Cell Res. 259 (1), 158166 (2000).
12. Lo, C. M., Keese, C. R., & Giaever, I. Impedance analysis of MDCK cells measured by electric cell-substrate impedance sensing. Biophys. J.
69 (6), 28002807 (1995).
Copyright © 2014 Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

March 2014 | 85 | e51300 | Page 11 of 12

Journal of Visualized Experiments

www.jove.com

13. Lo, C. M., Keese, C. R., & Giaever, I. Monitoring motion of confluent cells in tissue culture. Exp. Cell Res. 204 (1), 102109 (1993).
14. Opp, D., Wafula, B., Lim, J., Huang, E., Lo, J. C., & Lo, C. M. Use of electric cell-substrate impedance sensing to assess in vitro cytotoxicity.
Biosens. Bioelectron. 24 (8), 26252629 (2009).
15. Szulcek, R., Beckers, C. M. L., et al. Localized RhoA GTPase activity regulates dynamics of endothelial monolayer integrity. Cardiovasc. Res.
99 (3), 471482 (2013).
16. Liang, C.-C., Park, A. Y., & Guan, J.-L. In vitro scratch assay: a convenient and inexpensive method for analysis of cell migration in vitro. Nat.
Protoc. 2 (2), 329333 (2007).
17. Keese, C. R., Wegener, J., Walker, S. R., & Giaever, I. Electrical wound-healing assay for cells in vitro. Proc. Natl. Acad. Sci. U.S.A. 101 (6),
15541559 (2004).
18. Krishnan, R., Klumpers, D. D., et al. Substrate stiffening promotes endothelial monolayer disruption through enhanced physical forces. Am. J.
Physiol., Cell Physiol. 300 (1), 146154 (2011).
19. Van Nieuw Amerongen, G. P., van Delft, S., Vermeer, M. a, Collard, J. G., & van Hinsbergh, V. W. Activation of RhoA by thrombin in
endothelial hyperpermeability: role of Rho kinase and protein tyrosine kinases. Circ. Res. 87 (4), 335340 (2000).
20. Aman, J., et al. Effective treatment of edema and endothelial barrier dysfunction with imatinib. Circulation. 126 (23), 27282738 (2012).

Copyright © 2014 Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

March 2014 | 85 | e51300 | Page 12 of 12

